Chapter 808

Confidence Intervals for Spearman’s Rank Correlation

Introduction

This routine calculates the sample size needed to obtain a specified width of Spearman’s rank correlation coefficient confidence interval at a stated confidence level.

Caution: This procedure requires a planning estimate of the sample Spearman’s correlation. The accuracy of the sample size depends on the accuracy of this planning estimate.

Technical Details

This procedure is based on the results of Bonett and Wright (2000). Assuming a bivariate normal population with population rank correlation \( \rho \), the transformation of the sample Spearman’s rank correlation from \( r \) to \( z_r \)

\[
z_r = \frac{1}{2} \ln \left( \frac{1 + r}{1 - r} \right)
\]

is approximately normally distributed with variance \( 1/(n - 3) \) (Fisher, 1921). The lower and upper confidence limits for \( \rho \) are obtained by computing

\[
z_r \pm z_{1-\alpha/2} \sqrt{\frac{1 + r^2}{2n-3}}
\]

to obtain \( z_L \) and \( z_U \). The values of \( z_L \) and \( z_U \) are then transformed back to the correlation scale using the inverse transformations

\[
r_L = \frac{\exp(2z_L) - 1}{\exp(2z_L) + 1}
\]

and

\[
r_U = \frac{\exp(2z_U) - 1}{\exp(2z_U) + 1}
\]

One-sided limits may be obtained by replacing \( \alpha/2 \) by \( \alpha \).

For two-sided intervals, the distance from the sample correlation to each of the limits may be different. Thus, instead of specifying the distance to the limits we specify the width of the interval, \( W \).
The basic equation for determining sample size for a two-sided interval when $W$ has been specified is

$$W = r_U - r_L$$

For one-sided intervals, the distance from the sample correlation to limit, $D$, is specified.

The basic equation for determining sample size for a one-sided upper limit when $D$ has been specified is

$$D = r_U - r$$

The basic equation for determining sample size for a one-sided lower limit when $D$ has been specified is

$$D = r - r_L$$

Each of these equations can be solved for any of the unknown quantities in terms of the others.

---

**Confidence Level**

The confidence level, $1 - \alpha$, has the following interpretation. If thousands of samples of $n$ items are drawn from a population using simple random sampling and a confidence interval is calculated for each sample, the proportion of those intervals that will include the true population correlation is $1 - \alpha$.

---

**Procedure Options**

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

---

**Design Tab**

The Design tab contains most of the parameters and options that you will be concerned with.

**Solve For**

This option specifies the parameter to be solved for from the other parameters.

**One-Sided or Two-Sided Interval**

**Interval Type**

Specify whether the confidence interval for the population correlation is two-sided or one-sided. A one-sided interval is often called a **confidence bound** rather than a confidence interval because it only has one limit.

**Two-Sided**

The two-sided confidence interval is defined by two limits: an upper confidence limit (UCL) and a lower confidence limit (LCL).

These limits are constructed so that the designated proportion (confidence level) of such intervals will include the true population value.
Confidence Intervals for Spearman’s Rank Correlation

Upper One-Sided
The upper confidence interval (or bound) is defined by a limit above the estimated parameter value. The limit is constructed so that the designated proportion (confidence level) of such limits has the true population value below them.

Lower One-Sided
The lower confidence interval (or bound) is defined by a limit below the estimated parameter value. The limit is constructed so that the designated proportion (confidence level) of such limits has the true population value above them.

Confidence
Confidence Level
The confidence level, 1 – α, has the following interpretation. If thousands of samples of n items are drawn from a population using simple random sampling and a confidence interval is calculated for each sample, the proportion of those intervals that will include the true population correlation is 1 – α.

Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 0.90, 0.95 or 0.90 to 0.99 by 0.01.

Sample Size
N (Sample Size)
Enter one or more values for the sample size. This is the number of individuals selected at random from the population to be in the study.

You can enter a single value or a range of values.

Precision
Confidence Interval Width (Two-Sided)
This is the distance from the lower confidence limit to the upper confidence limit.

You can enter a single value or a list of values. The value(s) must be between 0 and 2.

Distance from r to Limit (One-Sided)
This is the distance from the sample correlation to the lower or upper limit of the confidence interval, depending on the Interval Type.

You can enter a single value or a list of values. The value(s) must be between 0 and 2.

Estimated Sample Spearman’s Rank Correlation
r (Sample Spearman’s Rank Correlation)
Enter an estimate of the sample Spearman’s rank correlation calculated from the usual formula. This value can be obtained from prior studies, expert opinion, or as a reasonable guess. The sample size and width calculations assume that the value entered here is the actual correlation estimate obtained from the sample. The accuracy of your results will depend on the accuracy of this estimate.

The range of the values of the sample correlation that can be entered is -1 to 1.

You can enter a range of values such as 0.1 0.3 0.5 or 0.1 to 0.5 by .2.
Example 1 – Calculating Sample Size

Suppose a study is planned in which the researcher wishes to construct a two-sided 95% confidence interval for the population Pearson correlation such that the width of the interval is no wider than 0.08. The researcher would like to examine a large range of sample correlation values to determine the effect of the correlation estimate on necessary sample size. Instead of examining only the interval width of 0.08, widths of 0.06 and 0.10 will also be considered.

The goal is to determine the necessary sample size.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Confidence Intervals for Spearman’s Rank Correlation procedure window by expanding Correlation, then Correlation, then clicking on Confidence Interval, and then clicking on Confidence Intervals for Spearman’s Rank Correlation. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

Option | Value
--- | ---
Design Tab | |
Solve For | Sample Size
Interval Type | Two-Sided
Confidence Level (1 – Alpha) | 0.95
Confidence Interval Width (Two-Sided) | 0.06 0.08 0.10
r (Sample Spearman’s Correlation) | -0.9 to 0.9 by 0.1

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Confidence Level</th>
<th>Sample Size N</th>
<th>Target Width</th>
<th>Actual Width</th>
<th>Sample Correlation r</th>
<th>C.I. Lower Limit</th>
<th>C.I. Upper Limit</th>
<th>Width if r = 0.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.950</td>
<td>225</td>
<td>0.060</td>
<td>0.060</td>
<td>-0.900</td>
<td>-0.926</td>
<td>-0.866</td>
<td>0.262</td>
</tr>
<tr>
<td>0.950</td>
<td>737</td>
<td>0.060</td>
<td>0.060</td>
<td>-0.800</td>
<td>-0.828</td>
<td>-0.768</td>
<td>0.144</td>
</tr>
<tr>
<td>0.950</td>
<td>1387</td>
<td>0.060</td>
<td>0.060</td>
<td>-0.700</td>
<td>-0.729</td>
<td>-0.669</td>
<td>0.105</td>
</tr>
<tr>
<td>0.950</td>
<td>2067</td>
<td>0.060</td>
<td>0.060</td>
<td>-0.600</td>
<td>-0.629</td>
<td>-0.569</td>
<td>0.086</td>
</tr>
<tr>
<td>0.950</td>
<td>2704</td>
<td>0.060</td>
<td>0.060</td>
<td>-0.500</td>
<td>-0.529</td>
<td>-0.469</td>
<td>0.075</td>
</tr>
<tr>
<td>0.950</td>
<td>3255</td>
<td>0.060</td>
<td>0.060</td>
<td>-0.400</td>
<td>-0.430</td>
<td>-0.370</td>
<td>0.069</td>
</tr>
<tr>
<td>0.950</td>
<td>3695</td>
<td>0.060</td>
<td>0.060</td>
<td>-0.300</td>
<td>-0.330</td>
<td>-0.270</td>
<td>0.064</td>
</tr>
<tr>
<td>0.950</td>
<td>4014</td>
<td>0.060</td>
<td>0.060</td>
<td>-0.200</td>
<td>-0.230</td>
<td>-0.170</td>
<td>0.062</td>
</tr>
<tr>
<td>0.950</td>
<td>4205</td>
<td>0.060</td>
<td>0.060</td>
<td>-0.100</td>
<td>-0.130</td>
<td>-0.070</td>
<td>0.060</td>
</tr>
<tr>
<td>0.950</td>
<td>4269</td>
<td>0.060</td>
<td>0.060</td>
<td>0.000</td>
<td>-0.030</td>
<td>0.030</td>
<td>0.060</td>
</tr>
<tr>
<td>0.950</td>
<td>4205</td>
<td>0.060</td>
<td>0.060</td>
<td>0.100</td>
<td>0.070</td>
<td>0.130</td>
<td>0.060</td>
</tr>
<tr>
<td>0.950</td>
<td>4014</td>
<td>0.060</td>
<td>0.060</td>
<td>0.200</td>
<td>0.170</td>
<td>0.230</td>
<td>0.062</td>
</tr>
<tr>
<td>0.950</td>
<td>3695</td>
<td>0.060</td>
<td>0.060</td>
<td>0.300</td>
<td>0.270</td>
<td>0.330</td>
<td>0.064</td>
</tr>
<tr>
<td>0.950</td>
<td>3255</td>
<td>0.060</td>
<td>0.060</td>
<td>0.400</td>
<td>0.370</td>
<td>0.430</td>
<td>0.069</td>
</tr>
<tr>
<td>0.950</td>
<td>2704</td>
<td>0.060</td>
<td>0.060</td>
<td>0.500</td>
<td>0.469</td>
<td>0.529</td>
<td>0.075</td>
</tr>
<tr>
<td>0.950</td>
<td>2067</td>
<td>0.060</td>
<td>0.060</td>
<td>0.600</td>
<td>0.569</td>
<td>0.629</td>
<td>0.086</td>
</tr>
<tr>
<td>0.950</td>
<td>1387</td>
<td>0.060</td>
<td>0.060</td>
<td>0.700</td>
<td>0.669</td>
<td>0.729</td>
<td>0.105</td>
</tr>
<tr>
<td>0.950</td>
<td>737</td>
<td>0.060</td>
<td>0.060</td>
<td>0.800</td>
<td>0.768</td>
<td>0.828</td>
<td>0.144</td>
</tr>
<tr>
<td>0.950</td>
<td>225</td>
<td>0.060</td>
<td>0.060</td>
<td>0.900</td>
<td>0.866</td>
<td>0.926</td>
<td>0.262</td>
</tr>
<tr>
<td>0.950</td>
<td>130</td>
<td>0.080</td>
<td>0.080</td>
<td>-0.900</td>
<td>-0.933</td>
<td>-0.853</td>
<td>0.344</td>
</tr>
<tr>
<td>0.950</td>
<td>417</td>
<td>0.080</td>
<td>0.080</td>
<td>-0.800</td>
<td>-0.836</td>
<td>-0.756</td>
<td>0.192</td>
</tr>
</tbody>
</table>
**Report Definitions**

Confidence level is the proportion of confidence intervals (constructed with this same confidence level, sample size, etc.) that would contain the true correlation.

Sample Size N is the size of the sample drawn from the population.

Width is the distance from the lower limit to the upper limit.

Target Width is the value of the width that is entered into the procedure.

Actual Width is the value of the width that is obtained from the procedure.

r is the estimate of Spearman's rho.

Lower and Upper Limit are the lower and upper limits of the confidence interval.

Width if r = 0.0 is the maximum width for a confidence interval with sample size N.

**References**


Fisher, R. A. 1921. ‘On the probable error of a coefficient of correlation deduced from a small sample.’ Metron, i (4), 1-32.

**Summary Statements**

A sample size of 225 produces a two-sided 95% confidence interval with a width equal to 0.060 when the estimate of Spearman's rank correlation is -0.900.

This report shows the calculated sample size for each of the scenarios.

**Plots Section**

![Plot of N vs r by C.I. Width](image)
These plots show the sample size versus the sample correlation for the three confidence interval widths.
Example 2 – Validation using Bonett and Wright

Bonett and Wright (2000), page 26, give an extension table of sample sizes for two-sided confidence intervals for Spearman correlations when the confidence levels are 95% and 99%. When the sample Spearman rank correlation is 0.3 and the interval width is 0.2, they obtain sample sizes of 334 and 574, respectively.

Note that we checked our results with this table and found a view differences which are obvious typos.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Confidence Intervals for Spearman’s Rank Correlation procedure window by expanding Correlation, then Correlation, then clicking on Confidence Interval, and then clicking on Confidence Intervals for Spearman’s Rank Correlation. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Interval Type</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Confidence Level (1 – Alpha)</td>
<td>0.95 0.99</td>
</tr>
<tr>
<td>Confidence Interval Width (Two-Sided)</td>
<td>0.2</td>
</tr>
<tr>
<td>r (Sample Spearman's Correlation)</td>
<td>0.3</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Confidence Level</th>
<th>Sample Size</th>
<th>Target Width</th>
<th>Actual Width</th>
<th>Sample Correlation</th>
<th>C.I. Lower Limit</th>
<th>C.I. Upper Limit</th>
<th>Width if r = 0.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.950</td>
<td>334</td>
<td>0.200</td>
<td>0.200</td>
<td>0.300</td>
<td>0.197</td>
<td>0.397</td>
<td>0.215</td>
</tr>
<tr>
<td>0.990</td>
<td>574</td>
<td>0.200</td>
<td>0.200</td>
<td>0.300</td>
<td>0.197</td>
<td>0.397</td>
<td>0.215</td>
</tr>
</tbody>
</table>

PASS also calculates the sample sizes to be 334 and 574.